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Meeting our Customers’ requirements … 
When in 1997 “SWater” idea was designed to meet our farsighted Customers’ specific 
requirements in wastewater market, it was still not clear how important and wide a new 
software approach could be in designing and testing of WWTPs. 
In spite of a large availability of a variety wastewater processes academic mathematical 
models, some authoritative WWTPs Techniciants and Operators had to be more and more 
complained of a general low functional applicability and flexibility of these models to real way 
of working of treatment plants, a part the objective difficulty to detect some of particular 
required parameters, not normally of routine checked in LABs (for ex.: COD soluble, etc.). 
The required more functional applicability and flexibility of mathematical models doesn’t mean 
to be satisfied with a more approximate approach: it’s just on the contrary! Certainly it is more 
approximate using complex and sophisticated math models (differential equations on bio-
kinetics and on biomass balances, etc.), when to design/upgrade or testing WWTPs, we are at 
last obliged to fix generic parameters as “constants” as from technical-scientific literature. 
But, and instead, it’s more realistic even to cope with a “stationary state” models, being able 
to detect not only a “Working Point” of a water treatment process, but with real “Working 
Areas” of functionality, very helpful to see the large of the plant operative working. 
But SWater is more then only all this. SWater uses an holistic approach, by analysing and 
testing wastewater (urban) processes, ables to verify different point of views of wastewater 
treatment process functionality to target the legal required effluent water quality limits. 
Finally, in 2010 it was designed “SWater Mix”: it comes to integrate wild needs of industrial 
WWTPs process design and simulation. 
 
An effective professional tool for water managers 
SWater is a software tool able to satisfy the real needs of process design, testing and 
upgrading of the urban or industrial wastewater treatment plants (WWTPs). You can quickly 
scan or fine-tune, pre- and primary treatment processes, biological nutrient removal or classic 
oxidation processes, effluent disinfection, sludge treatments, cost evaluations, etc. 
Many water-engineering companies adopt SWater in Europe and in the world (see the 
download-library of www.wateronline.com). Work with SWater to: 

• See directly if the current process can fulfil new targets or legal restrictions or where it 
should be changed; 

• Perform problem solving on the spot, analysing the effects of possible corrective 
actions; 

• Extend process knowledge using the software as an offline training tool. 
 
The holistic approach and the driver indicators 
SWater uses a holistic approach, by analysing and testing wastewater processes. It is based on 
the integration of traditional deterministic mathematical models (IAWPRC) and heuristic 
knowledge based softcomputing models related to wastewater processes. 
One crucial point of SWater is to show the “working area” of each treatment section. A visual 
indicator detects the process efficiency parameters in their range-ability, in order to notify by 
“earlywarning” (end-scale), a critical process-event in progress. 
 
Design and Testing on the click! 
SWater is the only software tool that allows users to operate in design and in testing mode at 
the same time just clicking on it! 
The design and testing are two points of view of the same target of SWater: a designed WWTP 
should satisfy its testing … and a tested WWTP should satisfy its design… 
For instance, given an existing WWTP, if you have to upgrade a classic (C) oxidation biological 
treatment in a nutrient (N and P) removal process, you probably have to cope with a mix of 
design (upgrade) and testing (the existing basin of biological reactor) problems! 
Switching from design-mode to test-mode, the selected process and its functioning can be 
tested directly showing its functioning with different input and conditions, 
without changing any window (all in a glance!). A unique aspect of SWater is the integration of 
traditional mathematical simulation models and the knowledge based soft-computing models. 
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In troduction 
With reference to a more than ten-years operative training and testing of the previous version 
SWater PRO, the well known MultiFunctional Testing & Upgrading Software Tool for Urban 
WasteWater Treatments Plants (WWTPs), SWater Mix 2010 comes to integrate wild needs of 
Industrial WWTPs process design and simulation. 
Main SWater Mix target applications are: 
1) Urban-industrial compliant mixed wastewater, exclusively delivered by sewage; 
2) Industrial wastewater (not urban compliant), exclusively delivered by trucks; 
3) Mix of above mentioned (1-2) wastewater contributions, both delivered (by sewage and 

trucks). 
SWater Mix 2010 is also able to detect and calculate residual rate of depuration capability 
coming  from each of scheduled (physic-chemical and biological) water/sludge treatments’ 
stages. 
One of SWater Mix peculiarity is the ability of its algorithms to allow a bidirectional “design and 
verification” functionality approach in process performances simulation, but a 
mix/simultaneous use of their too. 
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Applications 
 
SWater Mix 2010 is implemented for urban/industrial/mixed wastewater treatment plants or 
similar treatments, consisting of the following sections: 
 

WATER LINE TREATMENTS 
 
PRELIMINARY: Screening, Grit Removal, Lifting, Equalization 
CHEMICAL-PHTSICAL:    Initial-Storage/Homogenization, pH  

Neutralization, Coagulation-Flocculation, Chemical 
Precipitation, Final Homogenization 

PRIMARY:     Primary clarifier, Air Flotation 
SECONDARY :  Biological & Nutrient Removal, Secondary Clarifier 
TERTIARY: Emergy phosphorus chemical removal, Effluent 

Filtration, UV-C disinfection, Chlorination Basin 
 
SLUDGE LINE 
      THICKENING 

AEROBIC DIGESTION 
      ANAEROBIC DIGESTION 
      POST-THICKENING 
      SLUDGE DEWATERING 
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Installation and Start 
Hardware Required 
• Pentium II processor or higher. 
• At least 64M of RAM. 
• CD-ROM. 
• Space available on HD more than 20 MB. 
• SVGA Video Card. 
 
 
Software Required 
• Windows 9x, Windows 98/98SE, Windows 2000, Windows NT, Windows XP/Vista. 
• Microsoft Word 97 or following. 
• Windows Settings Recommended: 65000 colors or higher, 1024x768 resolution, small fonts. 
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Registration (Password) 
When you open the software, it appears SWater Mix 2010 registration (this window will 
appear each time you start SWater, until successful registration) (Fig.1). 
 
 

 
 

 
To contact ANOVA, click on "Order": it will appear a window with the default mail program. 
When you click  on the "DEMO" button, it opens the demo program, in which all functions are 
enabled. 
The evaluation version can be used for 30 days after which, to continue using the program, you 
should proceed with registration. When SWater Mix 2010 is open, a new way to access to the 
registration window is to select the entry in the menu Help (Fig.2). 
 

 
 
  

Fig.2: Registration from Help 

Fig.1: SWater Mix Registration 
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When you click on the "Register", it opens the window shown below (Fig.3), where it is shown 
the code relating to the PC where you installed the demo version of the program (software 
code). This code must be communicated to ANOVA in order to receive the registration 
password to be entered in the field (Liberation key). 
 

 
 

Start 
The program starts in a window displaying all the system files (with extension “.bfa”) available 
in the selected directory for the server location (read the status bar). You can now select an 
existing file by selecting "Open existing plant" and then double-click on the name of the plant, 
or you can decide to create a new plant by selecting the appropriate option and clicking on 
"Ok": a dialog box where you enter the name of the plant appears (Fig.4). 
 

 

Fig.3: SWater Mix Registration 

Fig.4: Open Plant or New Plant 
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If in the first window you press Cancel, enter the File menu, click on this new functionality and 
it will return to the window required for naming (Fig.5). 
 

 
 
 
 
Enter the name in the window (Fig. 6): 
 

 
 

 
On the left side of the active window it will appear a tree (treeview), whose branches 
represent the main types of treatments that exist in wastewater treatment plants. At this point 
only the voices loads (influent) and output (effluent) are active (Fig.7). 
 

  

Fig.6: Name of new plant  

Fig.5: New plant  

Fig.7: A new plant  
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Input Data 
SWater Mix 2010 is the only software that lets you switch between "Design" to "Testing" and 
vice versa, with just one click! 
Suppose you should transform a system characterized by a traditional secondary treatment 
with the only removal of organic carbon in an advanced nutrient removal with nitrogen and 
phosphorus: in this case it faces the problem of "mixed" design and testing, difficult to deal 
with traditional models. 

Design or testing a process are in SWater Mix 2010 only two aspects of the same problem: the 
correct functionality of the system in achieving the goals of treatment. 

1° Step: Loadings from Sewage 
When you click on ‘Loading from Sewage’ it appears on the right side a mask of these loads. In 
this mask and following, white cells are characteristics of the input data while the grays are 
typical outputs. The window will open 'Design' mode, the button will be characterized by the 
green color (Fig. 8). 
 

 
 

 
 
At this point, to work with SWater Mix 2010 you have to entry the population equivalent, into 
the field marked with the red frame as shown in the figure 8. 
Remember that all fields marked in red are areas that must be filled. 
 

  

Fig.8: Loadings from sewage  
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Note that: 
1. Each time you press [Enter], or the green button, characteristic of the working mode, the 

output will be calculated automatically and update the data. 
2. If you don’t have available all the data on the influent, you can use the default data present 

in Swater Mix 2010, that are: 
Unit Flow [l/cap*d] = 350 
Sewers influx factor ϕ = 0,8 
BOD5 [g/(capita*d) ] = 60 
SST [g/( capita*d) ] = 90 
TKN [g/( capita*d) ] = 12,5 
NH4

+ [g/( capita*d) ] = 8,7 
P [g/( capita*d) ] = 3,3 
MBAS [g/( capita*d) ] = 3,0 
Oil [g/( capita*d)] = 22 
in line with existing legislation on discharges of urban-industrial wastewater or equivalent 
(D.Lgs.152/99 et seq.). 

3. If default data loads aren’t in line with those of influent, you can change them as needed. 
4. If you have access to real data of the influent, as concentrations and flow rates, you can 

modify the same working in 'Testing' mode, pressing the homonymous button. 
5. In 'Testing' mode output cells 'Design' are input and can be easily modified as needed. 

Defined load 'Testing' mode, if you return 'Design' mode, you lose the data entered (daily 
average, maximum peak daily maximum and minimum), because the program will proceed 
back to the automatic calculation of data. 

Ultimately, the evaluation of hydraulic and pollution loads entering the plant is carried on the 
following considerations: 
 
# Reference DATA: 
� N. Population 
� Unit Flow [l/cap*d] 
� Sewers influx factor ϕ 
 
# FLOW calculation of Rain and Industrial: 
� Flow of Rain Qrain [m³/h] = 0.278 × ψ × i × A × 3600 
� Flow of industrial water Qind [m³/h] 

 
# Evaluation of the HYDRAULIC LOAD to TREAT in the plant: 
� Average daily flow (24h): 

Qmed24 [m³/h] = ϕ×DI×Nab/ 24000 + Q10ind / 10 
� Peak flow diurnal (14h):   

Qmax14 [m³/h] = Qmed ×24/14 = 1,7 ×Qmed24 
� Average diurnal flow (18h):  

Qmed18 [m³/h] = Qmed ×24/18 = 1,3 ×Qmed24 
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� Minimum flow at night (48h):    
Qmin48 [m³/h] = Qmed ×24/48 = 0,5 ×Qmed24 

 
� Total daily flow:   Qd[m³/d] = Qmed24 ×24  
 
# Assessment of the pollution load entering the plant:  
Referring to the following specific values: 
� BOD5 [g/(capita*d)]: 60 
� SST [g/(capita*d)]: 90 
� TKN [g/(capita*d)]: 12,5 
� NH4+ [g/(capita*d)]: 8,7 
� P [g/(capita*d)]: 3,3 
� MBAS [g/(capita*d)]: 3 
� Oil [g/(capita*d)]: 22 
It is possible to calculate the concentration values of the pollution load entering: 
� BOD5 [g/(capita*d)] 
� SST [g/(capita*d)] 
� TKN [g/(capita*d)] 
� NH4+ [g/(capita*d)] 
� P [g/(capita*d)] 
� MBAS [g/(capita*d)] 
� Oil [g/(capita*d)] 
The mass flow daily of BOD5 and TSS are: 

� BOD5 [g/(ab×d)] 
� SST [g/(ab×d)] 

Assuming a ratio (COD/BOD) equal to 2 we get the concentration of COD [mg/l]. 
 
If you have to simulate the pre-physical-chemical treatment of industrial wastewater, you 
should follow the steps below. 
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2° Step: Industral/Special Waste Loadings 
 
When you click on 'Industrial/Special waste loadings' appears on the right side a mask of these 
loads. In this mask and following, white cells are characteristics of the input data while the 
grays are typical outputs (Fig. 9). 
 

 
 

At this point, to work with SWater Mix 2010 you have to entry Q.ind.sp.waste, in the 
appropriate field highlighted with red rectangle, as shown in the figure 9, and click on "Enter." 
In the 'Industrial/Special waste loadings' is evaluated biodegradability (ie. compatible with the 
following biological treatment) treatment of industrial wastewater, according to the following 
parameters: 
a) Compatibility with the requirements of nutrition and metabolism of bacterial biomass, that 

carry out secondary biological treatment, ie. a relationship between the presence of 
substrate carbon (BOD) and nitrogen nutrients N and P content of phosphorus equal to: 

C : N : P  = 100 : 5 : 1. 
Furthermore, it is necessary that pH is essentially neutral (values between 6 and 8). 

b) Presence of quickly soluble carbonaceous substrate (BOD), ie. a ratio COD/BOD<2.5 
(where COD is the total carbon). In general, we can distinguish the following 
classifications: 

COD/BOD = 1,6 ÷ 2,5   Urban Wastewater (biodegradable) 
COD/BOD = 2,5 ÷5       Industrial Wastewater (little biodegradable) 
COD/BOD > 5                Industrial Wastewater (not biodegradable) 

Fig.9: Industrial/Special Waste Loadings  
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c) Presence of a ratio BOD/N≥3 for reasons given in paragraph a). 
d) The redox potential ORP provides guidance on the redox state of the wastewater sample in 

question. So, since ORP values > 0 mV indicates a wastewater aerated in which the 
oxidation purification are already carried out (very unlikely), while ORP between -50 and -
250 mV indicates a wastewater in anoxic conditions (likely for the type of wastewater) and 
ORP <-300 anerobiosi conditions that could harm to the biomass of secondary treatment, if 
not properly balanced. 

e) Conductivity is related to the presence of the reference sample ion (metal salts) in solution. 
This shows how high values of conductivity create problems for purifying biomass, since 
that for the potable water will have conductivity values of 600-800 microS/m, while for the 
sea water have values around at 10000-15000 microS/m. 

f) Absence of toxic or inhibiting substances such as heavy metals (cadmium, copper, lead, 
etc.).. 

The code for calculating SWater Mix 2010 includes the following cases of wastewater mixed 
urban-industrial: 
a) Qf flow of wastewater (urban and industrial compliant) delivered by sewage: depending on 

the content and the "weight" parameters biodegradability (BOD, TKN, pH, etc..), whole or 
part of Qf may be sent to pre-treatment chemical and physical, to be located at the 
secondary levels in the biological treatment. 

b) Qind flow of wastewater (industrial, not urban compliant) delivered by trucks: this kind of 
wastewater need to be treated and balanced before being sent to the following biological 
secondary treatment. 

c) Mix of above mentioned a) and b): while the whole Qind have to be sent to the chemical-
physical treatment, Qf have to balance the pollutant load from industrial wastewater (not 
urban compliant). So, it is necessary a storage stage in order to carry out an 
homogenization process. 
 

We show this process in the figure 10: 
 
 
 
 
 
 

 
 
The tractability of the plant can be verified used the following data: 

- COD/BOD; 
- BOD/TKN; 

by sewage 

       by trucks 

Chemical-physical 
Chemical sludge 

Storage 
1°Homogenization 

2° Homog. 

 

Depurative Plant  

1° 2° 3° Treatment 

Fig.10: Process of SWater Mix  
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- pH. 
When you have entered the value of "Q.ind.sp.waste", click "Enter" and it will appear the pre-
treatment stage of "Initial Storage/Homogenization " (Fig.11). 
 

 
  

When you click on "Initial Storage/Homogenization" (highlighted in the figure 11) the following 
screen appears (Fig.12), where the size of the storage volume and homogenization Vso is 
calculated based on the consideration that increasing Qf to be sent to chemical-physical, ie. 
Vso volume, surely you get the best results in terms of homogenization of the polluting input, 
but at the same time increases the cost of investment in infrastructure (Vso). 
Vice versa, if Qf is limited and therefore the volume Vso, the results worsen in terms of 
homogenization and, consequently, increase operating costs in terms of cost of reagents. 
 
When you click on "pH Neutralization" (highlighted in the figure 12) the following screen 
appears, where the pH adjustment can be realize with different methods, by mixing (with due 
caution in relation to phenomena of exothermic reaction) the dosage of reagents: 
 

Acid   
1 Sulfuric Acid H2SO4  
2 Hydrochloric Acid HCl 
3 Nitric Acid HNO3 

Basic   
10 Calcium Carbonate CaCO3  
20 Calcium Hydroxide Ca(OH)2  
30 Sodium Hydroxide NaOH  
40 Sodium Carbonate Na2CO3  

 

Fig.11: Initial storage homogenization appears  
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In the case of Swater Mix 2010, it was considered the use of corrective reagents (acids or 
basic), while to define the dosage in the absence of data on alkalinity, we will refer to a 
"Alkalinity factor"(see figure 13). 
 

 
 

When you click on "Coagulation-Flocculation" (highlighted in the figure 13) the following 
screen appears (Fig. 14), where the flow of wastewater that must undergo a chemical-physical 
treatment is determined in dependence of the contributions that reach the treatment plant 
(design and chemical dosage reagents, mixing, etc.). 

Fig.12: Initial storage/homogenization  

Fig.13: pH Neutralization  
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When you click on "Chemical Precipitation" (highlighted in the figure 14) the following screen 
appears (Fig. 15), where the design is related to the hydraulic load [m/h] that must be 
established, to the dosage of chemical reagents used and to the obtained reduction (Sizing 
Precipitation tank). 

Fig.14: Coagulation-Flocculation 
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When you click on "Final Homogenization" (highlighted in the figure 15) the following screen 
display output values resulting from treatments previously made (Fig. 16). 
 

Fig.15: Chemical Precipitation  
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Fig.16: Final Homogenization  
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Operative Menu 
All functionality of SWater Mix 2010 are accessible through the menu bar. 
 

 
 

Some functionality are also available through button bar.  
When you choose a plant, the software starts with the last saved data. 
When you click on "Open Data" from menu "File" (Fig. 17) or the corresponding button on the 
button bar, you can see the dates of the backups on the plant open (Fig. 18). 
 

 
 

You can select an item and so, clicking the "Open" button you will load the relevant data, and 
clicking “Delete” you will delete the data from the archive (Fig. 18). 
 

 
 

Fig.16: Menu bar 

Fig.17: Open Data 

Fig.18: Saved Data 
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When you select "Save Data" from the File menu or click the corresponding button on the 
button bar you can save data of the current configuration with the current date and time (Fig. 
19). 
 

 
 

 
The data will be saved in the directory path specified by the server. 
 
The menu item "File" "Save As ..." allows you to save the current configuration of the plant 
with the name and directory path chosen independently of current server directory selected.  
 

 
 

Choose of Language 
When the software starts, you can choose the language clicking on “Configuration” 
→”Language” →….(Fig. 21). 
 

 
 

Fig.19: Save Data 

Fig.20: Save As… 

Fig.21: Choose of language 
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You will now see a tree on the left, the basic structure of the system: loads, the water line with 
the various treatments’ sections, sludge and effluent line. This structure can be customized by 
the user by adding or removing sections of treatment (Fig. 22). 
 

 
 

When you will have established treatments’ sections of the plant, you can configure design-
testing steps which will appear, independently, on the right side of the main window. 
Server Path 
After choosing the language, at the first installation of the program, it will be required to 
indicate the location of the directory used to contain files with the extension ".bfa", generated 
during the use of the program. 
You can also select directories on other networked computers (Fig. 23). 
 

 
 

The sample files are in the installation directory ( default C:\Anova\Swater Mix). 

Fig.22: Treeview 

Fig.23: Files path 
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Swater Mix 2010 is a software "multi-user", since you can open and/or save data on a central 
server which is connected to different terminals on which you installed the program. It will 
appear a window like in the figure 24, that lets you choose the wished path. 

 
 

The current server path is readable at any time on the status bar located on the bottom of the 
window (Fig. 25). 

 
 
 

Simulation and Verification of the Effluent Limits 
From the menu "Simulation" you can access to the sections of the environmental testing 
secondary biological treatment: this functionality is directly responsible for coping effluent 
limits (Fig. 26). 

Fig.24: Files path 

Fig.25: Current path 



26 
 

 
 
 

 Help 
This quick guide is available clicking on menu “Help” → “Help” (Fig. 27). 
 

 
 
 

Fig.27: Help 

Fig.26: Simulation 
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Abbreviations 
When you click on "Abbreviations" from menu "Help", you can access to the list of 
abbreviations used by Swater Mix 2010 (Fig. 28). 
 

 
 
 
 
 
 
 
 
 
 

Fig.28: Abbreviations 
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An Example 
When you click on “Open plant”, you can find 6 examples, that can help you learn more about 
SWater Mix. These examples are: 

1. Template #1; 
2. Template #2; 
3. Template #3; 
4. Dairy; 
5. Leachate; 
6. Drain septic tanks. 

The examples 1, 2 and 3 refer to urban wastewater; the examples 4, 5 and 6 refer to 
urban/industrial/mixed wastewater. 
To help you learn more about SWater Mix, we show you an example with default data (pag. 13 
paragraph 2). 
So, when you open SWater Mix and click on “Loadings from sewage” you could entry these 
default data: 
• Unit Flow [l/cap*d] = 350 
• Sewers influx factor ϕ = 0,8 
• BOD5 [g/(capita*d) ] = 60 
• SST [g/( capita*d) ] = 90 
• TKN [g/( capita*d) ] = 12,5 
• NH4

+ [g/( capita*d) ] = 8,7 
• P [g/( capita*d) ] = 3,3 
• MBAS [g/( capita*d) ] = 3,0 
• Oil [g/( capita*d)] = 22 

Supposing that you are in “Design” mode; so, if you entry a population (N. population cell) 
equals to 80.000 you should be obtain these results (Fig. 29).  
 

 Fig.29: Expected  Results for Loadings from sewage 



29 
 

Supposing that you want to add a “Preliminary treatments”, and in particular a “Screening”, 
you have to click with right button on “Preliminary treatments” on treeview, and so on “Add 
Screening” (Fig. 30 – Fig 31). 
 

 
 
  

 
 
  

Fig.30: Add Screening 

Fig.31: Screening 
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When you click on “Screening” on the treeview it will appear in right side, the window in figure 
32, where we show the expected results for “Screening” (based on default data, previously 
entered). 
 

 
 
 
Supposing that you want to add a “Primary Clarifier”. You have to click with right button on 
“Primary Treatments” and so on “Add Primary Clarifier” (Fig. 33 – Fig. 34).  
 

 

Fig.32: Expected results for “Screening” 

Fig.33: Add “Primary clarifier” 
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When you click on “Primary Clarifier” in treeview, you will obtain the window in figure 35, 
where we show the expected results for “Primary Clarifier” . 
 

 
 
 
Now, supposing that you want to add a secondary treatment: so, you should be click with right 
button on “Secondary treatment” in the treeview, and then on “Add Nutrient Removal” (Fig. 
36).  

Fig.34: Primary Clarifier 

Fig.35: Expected results for “Primary Clarifier” 
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So, it will appear “Biological & Nutrient removal” and “Secondary clarifier” (Fig. 37).  
 

 
 
 

If you click on “Biological & Nutrient Removal”, you will obtain these results (Fig. 38):  
 

Fig.36: Add Nutrient Removal 

Fig.37: Biological & Nutrient Removal – Secondary Clarifier 
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Since that we have add a “Primary Clarifier”, BOD5in value is decremented, and so it results 
BODmin (=200) > BOD5in (=160,7). To correct this, we modified BODmin value in 150 
(highlighted in fig. 39). The error message disappears. 

Fig.38: Expected results for Biological and Nutrient Removal 
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In figure 40 we show the expected results when you click on “Secondary Clarifier”. 

Fig.39: Expected results for Biological and Nutrient Removal 
when we change BODmin value 
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If you want to change Vox/nitr value in “Biological & Nutrient removal”, you have to go in 
“Testing” mode. So, supposing that you change this value in 9000 (highlighted in Fig. 41), it will 
appear these results (Fig. 41).  
 

Fig.40: Expected results for Secondary Clarifier 
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Fig.41: Results expected for Biological & Nutrient Removal when you 
are in “Testing” mode and when you change Vox/nitr value 
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For Assistance:              anova@anova.it 
 
 
Ing. Giovanni Mappa 
ANOVA s.a.s. 
Centro Direzionale Isola G1, scala C 
80143 Napoli 
 
Tel: 081 - 7502535 
Fax: 081 - 6051845 
 
www.anova.it 
e-mail: anova@anova.it 


